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Important Info & 2021 Changes 

No Prints Unfortunately, there will be NO Print Competition in 2021 due to Covid 19. 

Category 
Renaming 

The Wildlife Category has been renamed “Animals”. However, the criteria for 
entries into this – and all other Categories - remain exactly the same. 

Digital File 
Naming 

Be sure to reference the Digital File Naming guidelines because they have 
changed. Please do NOT reference any prior year procedures. 

New Group 
Designations  

We now have THREE Groups in which our Members may choose to compete.  

• Novice/Intermediate Group (Group N) 

• Advanced Group (Group A) 

• Expert Group (Group E) 

As a starting point the CCR Board is asking everyone to SELF-SELECT 
into the Group where you feel you best belong. 

EOY Judging Judging for the End of Year Competition will take place on November 13, 2021.  

Scoring and 
Merited 
Awards 

As in the past, three top photography experts will assign scores of up to 9 points 
each, for a maximum total of 27 points per image. Those scores are then used 
to rank the entries in each Category from highest to lowest to determine 1st, 2nd, 
and 3rd Places, as well as Honorable Mentions. Any resulting ties are decided 
by the judges. 

We are utilizing the judges’ scores as before but will now apply a Minimum 
Total Score (MTS) threshold, so ALL qualifying images are recognized within 
their respective Category and Group.  

The Novice/Intermediate Group’s score threshold is lower than the Advanced 
Group’s, and the Expert Group has the highest score requirement.  

The number of Awards within a Category will be determined by how many 
photographs meet these qualifications. If no entries within a Category reach the 
Minimum Total Score threshold, then no Awards will be given.  

Award 
Winners 

The winners will receive an official certificate acknowledging their 
achievement(s).  

Winning images will be also posted in a Member Gallery on the CCR Website 
and will be featured on the CCR facebook page and published in our monthly 
publication, “Southern Exposure”. 

 

  

https://www.cameraclubofrichmond.com/f291800482
https://www.facebook.com/CameraClubOfRichmond/
https://www.cameraclubofrichmond.com/ccr-newsletter---southern-exposure
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Group 
Advancement  

Beginning in 2021, entrants will start accumulating “Credits” based on 
how many total awards are won, over no more than a running 3-year 
timeframe. When an individual’s Credit totals reach the benchmark 
amount, they will graduate up to the next Group.  

Once a photographer advances to a higher Group, s/he starts over with 0 
Credits. If their Credit totals do not meet the advancement amount, no 
Group change is required. ANY photographer may self-advance into a 
higher Group if s/he wishes. Once a photographer moves to a higher 
Group, s/he may only move downward by petitioning the CCR Board for 
approval. 

Credit Amounts: 

• 1st Place = 3 Credits 

• 2nd Place = 2 Credits 

• 3rd Place = 1 Credit 

• Honorable Mention = 0 Credits 

• Major Awards = 0  

Advancement Criteria 

• Novice/Intermediate Group advances at 25 or more total Credits 

• Advanced Group advances at 30 or more total Credits 

EOY Award 
Presentation 

Winners will be announced at the annual Awards Presentation to be 
held on Wednesday, December 8, 2021. (Details to follow.) 

Permissions By entering this competition, you agree to allow the publication/display of 
your images on the CCR website, facebook page, and in our monthly 

publication, “Southern Exposure”. 
 

 

https://www.cameraclubofrichmond.com/
https://www.facebook.com/CameraClubOfRichmond
https://www.cameraclubofrichmond.com/ccr-newsletter---southern-exposure
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General Rules 

1. The Camera Club of Richmond End of Year Competition allows each member to enter up to 
TWELVE images in the contest and are subject to these rules: 

• Images that are submitted throughout the year into Image Evaluations* are called 
Standard Images, and you may enter up to twelve. 

• You may opt to substitute up to FIVE images that were NOT previously evaluated. 
These images are called Wildcards. 

2. Photographers submitting images for the EOY Competition must be Camera Club of 
Richmond Members in good standing, having paid the current year Membership Dues. 

3. All submissions, camera work (including staging and post-production), as well as any 
“creative changes” must be the work of the photographer submitting the image. 

4. Images made while under the immediate direction or technical supervision of another 
person are not eligible. (For example, being given specific exposure and technical 
settings by an instructor while attending a photo outing, seminar, class, trip, or safari are 
not eligible.) 

5. An image may only be entered once into an EOY Competition. (For instance, the image 
may not be entered as both a B&W and a Color image, or into two different Categories.) 

6. Images may NOT include the photographer's name on the face of the image. 

7. Entries must be submitted with the proper Digital File Name and correct format. 

8. You may also add a digital frame or mat to your submission to give it a “finished” 
presentation. See Anthony Rumley’s Video on CCR’s YouTube channel for instructions. 

9. Post Processing Guidelines: 

• In the General Categories (Animals, Architecture, Flora, Landscape, Pictorial and 
Portrait), images may be edited, however, post-processing may be used only to enhance 
the existing image to ensure realism. Minimal changes are allowed to: exposure, 
overall color and tone, sharpening, cloning (for minor retouching), contrast, cropping, 
and rotation.  

• The Special Categories (the 3 Assigned Subjects and Creative Art) are intended to 
show the photographer’s creativity and skills to enhance an image. You may combine 
elements from multiple images and use unlimited post-processing, including filters and 
creative imaging software. Images in these categories will be judged on their 
imagination, creativity, uniqueness, and editing. 
 

*The Camera Club of Richmond (CCR) offers six Image Evaluations to our members each year. 
Members are invited to submit one or two images that will be reviewed and critiqued by a 
seasoned/professional photographer during those designated monthly meetings (See CCR 
Meeting Schedule for specific dates for Evaluations.)  

https://www.youtube.com/watch?v=iGLlhrQyf_M&t=24s
https://www.cameraclubofrichmond.com/image-evaluations
https://www.cameraclubofrichmond.com/2021-meeting-schedule.pdf
https://www.cameraclubofrichmond.com/2021-meeting-schedule.pdf
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Category Names, Abbreviations, & Descriptions 

 

Animals 
(An) 

Animal photography traditionally refers to images of undomesticated animal species that 
normally live in the wild. Animal Photography documents various forms of wildlife in a 
natural or simulated habitat. An example of simulated habitat would be an image of a 
captive animal in a zoo that does not show cages, buildings, or other man-made 
construction not present in its natural surroundings. The incidental presence of animals 
(e.g., distant birds, cattle, etc.) or manmade objects (e.g., distant fences, vehicles, etc.) is 
acceptable. 

Architecture 
(A) 

Architectural photography is the photographing of buildings and similar man-made 
structures that are accurate representations of their subjects. 

Creative Art 
(CA) 

Creative Art is an extension of conventional photography and post-processing into creative 
art. Its purpose is to stimulate those creative thoughts and encourage experimentation with 
new ideas going beyond a simple photograph. 

Flora  
(F) 

Flora photography is a photograph of plant life occurring in a particular region or timeframe.   

Landscape  
(L) 

Landscape photography shows spaces within the world, sometimes vast and unending, but 
other times of a smaller scope. Landscape photographs typically capture the presence of 
nature (e.g., panoramic views of the Grand Canyon, or a Seascape) with a primary 
emphasis on the natural subjects.  A Landscape can also focus on man-made features or 
disturbances within the natural landscapes (e.g., Richmond Skyline from the Flood Wall, 
etc.) 

Portrait 
(PO) 

Portrait photography is a photograph of a person or group of people that captures the 
personality, traits, or faculties of the subject by the use of effective lighting, backdrops, 
poses, direction, or post-processing. Street Photographs meeting these criteria may also 
qualify as Portraits. 

Pictorial  
(PI) 

Pictorial photography is a general photography category. It might be an image of Still Life, a 
Causal Pictorial of a person or pet (not a formal Portrait), Street Photography, Travel 
Images, Photojournalism, or any image not previously addressed in another category. This 
would be the category for pet photography, whether posed or just spontaneous. 

Assigned 
Subjects 

(AS_B) 
(AS_P) 
(AS_L) 

Any image previously submitted to a Monthly Evaluation as an Assigned Subject. The 
Assigned Subjects for 2021 are: 

Backlighting 
Looking Up or Looking Down (from a different perspective) 
Low Light 

 

Submitted images that do not meet the requirements of the Category 

 may be disqualified at the judges’ discretion. 

https://en.wikipedia.org/wiki/Domestication
https://en.wikipedia.org/wiki/Animal
https://en.wikipedia.org/wiki/Species_(biology)
https://en.wikipedia.org/wiki/Wildlife
https://en.wikipedia.org/wiki/Nature
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Color Designations 

Images may be submitted as either Color Images or Black and White Images. 
 

Color 
(C) 

Color images are shot in full color or contain any color other than black 
and white. 

Black & White 
(BW) 

Black & White images are monochrome images, including infrared 
photographs, produced in black and white or in varying tones of only one 
color. Images that are primarily monochrome but contain added color to 
part of the image should be submitted as Color, NOT as B&W. 

 
 

Media Types 

In 2021, we will not have a Print Competition, therefore all images submitted 
should designate the Media Type “D”. 

 

Digital Images 
(D) 

Digital images must be submitted as .jpg files. Refer to Digital 
Submission Rules for specific guidelines on sizing and submitting Digital 
Images. 
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Submission Criteria 

Digital Submission Rules 

The Digital Director needs digital files to organize the hundreds of images being judged. In 
addition, the CCR Webmaster will create a Member Gallery of all winning images on the CCR 
Website and images will be featured on the CCR facebook page and in our monthly publication, 
“Southern Exposure”. 

You must submit a properly formatted and sized digital image by the general deadline: Midnight, 
October 16, 2021.  

Here are the specifications: 

• Digital images must be in jpg format. 

• The longest side of your digital image must not exceed 1920 pixels. 

If necessary, please see separate procedures for: 

• Resizing Digital Images in Adobe Lightroom 

• Resizing Digital Images in Adobe Photoshop 

Digital File Naming 

Digital images must be properly named so that the hundreds of submissions can be more easily 
sorted and evaluated. Be sure to change your digital file name to follow this Naming Convention 
when submitting your digital image: 

[Media Type]_[Category Abbreviation]_[Color Designation]_[Group]_ 
[Title of Image]_[Standard or Wildcard]_[Your Name].jpg 

OMIT the Brackets ([]) 

INCLUDE the Underscores (_) 

INCLUDE any necessary Spaces or Dashes in Your Name and your Image Title. 

Use only jpg file type. 

For example, this file name: 

D_L_C_A_On a Clear Day_WC_Karen Davis.jpg 

would represent a  
[D]igital Image 

[L]andscape Category 
[C]olor Image 

Group [A] 
Entitled: On a Clear Day 

[WC] Wild Card (Not previously submitted) 
By Photographer: Karen Davis 

https://www.cameraclubofrichmond.com/f348515942
https://www.facebook.com/CameraClubOfRichmond/
https://www.cameraclubofrichmond.com/ccr-newsletter---southern-exposure
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Digital File Submission Instructions 

All digital images must be emailed to the Digital Director by MIDNIGHT, October 16, 2021 at this 
address: Digital.CCRVA@gmail.com.  

Email your jpg files (2 or 3 at a time) following these guidelines: 

  To: Digital.CCRVA@gmail.com  

  Subject: EOY Competition  

  Click the Paper Clip icon to attach your digital file(s).  
  Please do not imbed the photo into the body of your email. 

You will receive an automated confirmation from the Digital Director’s mailbox. If you have not 
received this confirmation by the next day, you should contact him/her to verify that your files were 
received. 

For Help 

If you need help, feel free to contact any of our CCR Board Members, starting with: 

   Digital Director: Digital.CCRVA@gmail.com 

   Print Director: Prints.CCRVA@gmail.com 
a 

 

mailto:Digital.CCRVA@gmail.com
mailto:Digital.CCRVA@gmail.com
https://www.cameraclubofrichmond.com/ccrdirectors.pdf
mailto:Digital.CCRVA@gmail.com
mailto:Prints.CCRVA@gmail.com
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End of Year Awards 

Following the lead of several other photography associations and clubs, CCR is changing the way we 
determine EOY Awards for our images. We are putting the emphasis on Merited Images, so that all 
meritorious images are recognized. 

Instead of assigning awards based on the number of entries in each Category/Color Designation & 
Group as we have done in the past, the CCR Board will now assign a Minimum Total Score (MTS) 
for each Group. Those MTS levels will increase commensurate with the skill levels (i.e., 
Novice/Intermediate MTS will be lower than Advanced; and Advanced will be lower than Expert.) 

• All images meeting the MTS threshold for a Category/Color Designation/Group will earn 
awards.  

• Any ties will be decided by the judges. 

• If all three of the highest scoring images meet the MTS, then 1st, 2nd, and 3rd place awards will 
be given. 

• Any additional images meeting the MTS will be awarded Honorable Mentions. 

• Awards for Assigned Subjects 
o All Groups will be judged together in the three Assigned Subject Categories. 
o 1st , 2nd, and 3rd Place Awards will be given to the three images with the highest point 

scores. 
o Honorable Mentions will be awarded according to the MTS for each Group. 

Winners of these EOY Awards will receive a lovely certificate (suitable for framing!) acknowledging 
this achievement. 

Note: If no entries in a Category/Color Designation/Group meet the MTS, then no Awards will be 
given. 

Memorial (Best) Awards 

The EOY judges will also select four outstanding images for the Camera Club of Richmond’s 
Memorial (Best) Awards. The winners of these awards will receive trophies (to grace their 
bookshelves!) 
 

Award: Name Given to the Award: 

Best Color Digital W.A. Yoder Award 

Best B&W Digital Phillip Luce Award 

Best Assigned Subject Hyman Rose Award 

Best in Show Bernard Howell Award 
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References, Support, & Helpful Hints  

From a Judge’s Point of View 

1. Overall 
Impact/ 
Impression 

Does the image tell a “story” and is the subject of the image 
appropriate to the story? Does the image evoke emotion? Does the 
image have a “wow” factor? 

2. Technical 
Factors 

Does the image display focus, depth of field, exposure, lighting, 
contrast, and color balance (or tonal scale in black and white images) 
that are appropriate to the subject matter and the “story” being told by 
the photographer? 

3. Creativity Is the photo original and fresh in composition and/or in the use of 
lighting, perspective, color, special effects, etc.? 

4. Composition Is the design of the image visually pleasing or disturbing depending on 
the intent of the photographer? Do the elements of the image hold the 
observer and easily draw him/her to its subject? Does the composition 
come together as a whole, providing balance or lack thereof as 
appropriate to subject matter and the “story”? 

5. Finishing If present, do physical or digital mats, borders, vignetting, etc. add to 
the photo or distract from it? 

 

Remember that each Evaluator and Judge is expressing his or her own personal opinion and that 
“Beauty is in the eye of the Beholder” – AND the Photographer! 
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How Do I Select a Category? 

The selection of a Category for your award-winning image can be a daunting task. If you enjoy 
surfing the net there are numerous articles, statements, and self-proclaimed authorities who describe, 
define, and declare what is right and what is wrong. Nevertheless, this is time-consuming and 
confusing at best. 

One method, used by pros and amateurs, is to ask yourself a few personal questions about your 
motive for capturing that image. For example, was your motive to: 

• Shoot that elusive tiger on your African Safari? He would be in Animals. 

• Document a historical cathedral? Then, it would fit into Architecture. 

• Preserve the color and texture of a beautiful blossom? This would be Flora.  

• Show the magnitude of a vast desert? This would be a Landscape. 

• Tell a story or show an event? This would be Pictorial. 

• Capture the beauty or emotion of a particular individual? This is a Portrait. 

• Combine multiple images and/or demonstrate your post processing skills? This would be 
Creative Art. 

 
If you answer your “motive” question honestly, you will probably select the correct Category. 
 
Our six General Categories are: 

• Animals  

• Architecture 

• Flora 

• Landscape 

• Pictorial 

• Portrait 

 
A seventh, Special Category exists to allow unlimited, creative post-processing edits: 

• Creative Art 
 

At the beginning of each year, the CCR Board announces three special Categories referred to as 
“Assigned Subject” Categories for that year. The intent is to challenge our Photographers to try 
something new or stretch their post processing skills (since these Categories also allow unlimited, 
creative post-processing edits). This year, those Categories are: 

• Backlighting 

• Looking Up or Looking Down (from a different perspective) 

• Low Light 

  



 

 

2021 End of Year Competition  
 

Revised: October 1, 2021 
 

Karen Taylor Davis Back to Table of Contents 12 

Glossary of Important Terms 

Assigned 
Subjects 

At the beginning of each year, the CCR Board announces three special 
Categories referred to as “Assigned Subject” Categories for that year. The 
intent is to challenge our photographers to try something new or stretch their 
post processing skills (since these categories allow unlimited post-processing 
creativity).  

Black & White 
Images 
[BW] 

The Color Designation BW refers to Black & White images. They are 
monochrome images, including infrared photographs, produced in black and 
white or in varying tones of only one color. Images that are primarily 
monochrome but contain added color to part of the image should be 
submitted as Color, NOT as B&W. 

Camera Club of 
Richmond 
Member 

A CCR Member is one who has paid Membership Dues for the current year. 
All CCR Members are eligible to submit images for Image Evaluations (held 
during monthly CCR Meetings) as well as participate in the End of Year 
Competition. 

Camera Club of 
Richmond Dues 

CCR dues for FULL membership in the club are $40. 

Please note: Membership in CCR MeetUp (MeetUp.com/Camera-Club-of-
Richmond) is free, however if you only belong to CCR MeetUp, you are 
NOT eligible to submit images for Image Evaluations or participate in the 
End of Year Competition. 

Categories These are the general groups to which you will submit your images for the 
End of Year Competition. See the official Category list for guidance on 
where to place your photos or contact any CCR Board Member for help. 

Color Designation Color Designation refers to the range of colors contained in your image. 

Black & White (B&W) images are monochrome images, including infrared 
photographs, produced in black and white or in varying tones of only one 
color. Images that are primarily monochrome but contain added color to part 
of the image should be submitted as Color, NOT as B&W. 

Color (C) refers to images shot in full color or containing any color other than 
black and white. 

Color Images 
[C] 

The Color Designation Color refers to images shot in full color or containing 
any color other than black and white. 

 
 
 
 

https://www.cameraclubofrichmond.com/image-evaluations
https://www.meetup.com/Camera-Club-of-Richmond/
https://www.meetup.com/Camera-Club-of-Richmond/
https://www.cameraclubofrichmond.com/image-evaluations
https://www.cameraclubofrichmond.com/ccrdirectors.pdf
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Credits In 2021, CCR will be adding a new dimension our EOY Competition. The 
Awards earned will be assigned “Credits”: 

• 1st Place = 3 Credits 

• 2nd Place = 2 Credits 

• 3rd Place = 1 Credit 

• Honorable Mention = 0 Credits 

• Major Awards = 0 Credits  
(since they have already received 3 Credits for earning 1st Place) 

Photographers will accumulate “Credits” to determine when they will graduate 
to a higher Group. Records will be kept beginning with the 2021 EOY 
Competition and will be cumulative within each Group for a running 3-
year timeframe.  

Note: Credits earned as a “Novice/Intermediate” are used to determine when 
to move up to “Advanced”. Once there, you begin again with “0” and 
accumulate “Advanced Credits” to determine when you move to “Expert”.  

End of Year 
Competition 
(EOY) 

CCR holds a competition at the end of each year and invites members to 
submit up to 12 photographs to compete for awards in several different 
Categories. Up to five of those photos may be Wildcard Images. The other 
images (called Standard Images) must have been evaluated at one of the 
monthly CCR Image Evaluations during the current year. 

These photos are due in October and judged by a panel of experienced 
photographers – usually from outside the Richmond area – in November. 
Awards are presented at our CCR Awards Presentation (and hopefully, a 
Banquet!) which is held in place of our regular CCR meeting on the second 
Wednesday in December. 

EOY Groups for 
2021 

 
[N] 

 
 

[A] 

 

 
 

[E] 

CCR now offers THREE Groups in which our photographers will vie for 
awards in our EOY Competition. In 2021, all members will self-select into 
the Group they wish to participate.  

Novice/Intermediate Exhibitor – Group N 

This group is for new/novice CCR Members who feel they are just beginning 
to master their photography skills. 

Advanced Exhibitor - Group A 

This Group is for Members who feel that they have “advanced” photography 
skills beyond the “novice” or “intermediate” level. 

Expert Exhibitor - Group E 

This Group is for Members who feel that they have “expert” photography 
skills, consistently placing 1st, 2nd, or 3rd in prior EOY Competitions. 

ANY photographer may self-select into a higher Group if s/he wishes.  

https://www.cameraclubofrichmond.com/image-evaluations
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Once a photographer moves to a higher Group, s/he may only move 
downward by petitioning and being approved by the CCR Board. 

Image Evaluations Six times a year, CCR holds an Image Evaluation during our regular Monthly 
Meeting. CCR Members (who have paid their Annual Dues) are invited to 
submit 1 or 2 images for review. We invite a professional/experienced 
photographer or local artist to review these images and provide constructive 
feedback to help us learn and improve as photographers. 

JPG JPG stands for Joint Photographic Experts Group. JPG is the standard file 
format for compressing digital images so they can be stored or sent by email 
more easily. CCR requires that all images submitted for Image Evaluations 
and End of Year Competition are in the JPG file format (extension “.jpg”). 

JPEG Please do NOT use “JPEG” file extension on the digital submissions, 
use the extension “.jpg” Instead. 

Media Type 
[D] 

In 2021, images may only be submitted as Digital Images The specific 
requirements for submission are contained in this procedure: Digital 
Submission Rules. 

Minimum Total 
Score (MTS) 

Following the lead of several other photography associations and clubs, CCR 
is changing the way we determine Awards for our images. We are putting the 
emphasis on Merited Images, so that all meritorious images are recognized.  

Instead of assigning Awards based on the number of entries in each 
Category, the CCR Board will now assign a Minimum Total Score (MTS) for 
each Group. Those MTS levels will increase commensurate with the skill 
levels (i.e., Novice/ Intermediate MTS will be lower than Advanced; and 
Advanced will be lower than Expert.) 

• All images meeting this MTS threshold for a Category/Color 
Designation/Group will earn awards.  

• Any ties will be decided by the judges. 

• If all 3 of the highest scoring images meet the MTS, then 1st, 2nd, and 
3rd place awards will be given.  

• Any additional images meeting the MTS will be awarded Honorable 
Mentions. 

• Awards for Assigned Subjects 
o All Groups will be judged together in the three Assigned Subject 

Categories. 
o 1st, 2nd, and 3rd Place Awards will be given. 
o Honorable Mentions will be awarded according to the MTS for each 

Group. 

Note: If no entries in a Category/Color Designation/Group meet the MTS, 
then no Awards will be given. 

https://www.cameraclubofrichmond.com/image-evaluations
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Naming 
Convention for 
EOY Competition  

The prescribed way that digital images must be named for the EOY 
Competition is so that the hundreds of submissions can be properly sorted 
and evaluated. Here is the format: 

[Media Type]_[Category Abbreviation]_ 
[Color Designation]_[Group]_[Title of Image]_[Standard or Wildcard]_ 

[Your Name].jpg 

When you name your digital files: 

OMIT the Brackets ([]) 

INCLUDE the Underscores (_) 

INCLUDE any necessary Spaces or Dashes in Your Name and your 
Image Title. 

Use only jpg file type. 

For example, this file name: 

D_AS_L_BW_E_Double-Crossed_ST_Carol Hagaman.jpg 

would represent a 

[D]igital Image 
in the [AS]signed Subject [L]ooking Up or Looking Down Category 

[BW] Black & White Color Designation 
in the Expert Group [E] 

Entitled: Double-Crossed 
[ST]andard Image (i.e., was previously submitted for Image Evaluation) 

By Photographer: Carole Hagaman 

Standard Images 
[ST] 

Standard Images are those images that were submitted for Image 
Evaluations during the current year. You are allowed to submit up to 12 
Standard Images for the EOY Competition. 

Wildcard Images 
[WC] 

Wildcard Images are those images that were NOT submitted for an Image 
Evaluation during the current year. FIVE of the images you submit for the 
EOY Competition may be Wildcards. And yes – you may submit just the five 
Wildcard images if you wish. There is no requirement to submit Standard 
Images at all. 

 
  

https://www.cameraclubofrichmond.com/image-evaluations
https://www.cameraclubofrichmond.com/image-evaluations
https://www.cameraclubofrichmond.com/image-evaluations
https://www.cameraclubofrichmond.com/image-evaluations
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Resizing Images in Adobe Lightroom 

Why do I need to resize my images? 

CCR Accepts digital images for the following:  

• Image Evaluations at Monthly Meetings 
• End of Year Competition 

• Online Member Photo Galleries 
• Monthly Southern Exposure 
• CCR facebook page (we request a watermarked version for facebook) 

All images submitted for any of the above must be as close to and cannot exceed 1920 pixels 

on the longest side of that image. Before resizing your image, be sure ALL IMAGE EDITING IS 
COMPLETE and you are ready to submit your image. 

How do I resize my images in Adobe Lightroom? 

Open Lightroom and select the image you want to resize. 

Select File > Export. You will see the following screen: 

  
 

Follow these guidelines for each of the fields: 

File Naming Custom Name This is where you can rename your file according to the 

proper Naming Convention. 

https://www.cameraclubofrichmond.com/image-evaluations
https://www.cameraclubofrichmond.com/f348515942
https://www.cameraclubofrichmond.com/f348515942
https://www.cameraclubofrichmond.com/ccr-newsletter---southern-exposure
http://www.facebook.com/?CameraClubofRichmond
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 Custom Text Enter your new file name in this box. 

Video No Action  

File Settings Image Format JPG 

 Color Space sRGB 

 Limit File Size to N/A 

Image Sizing ✓ Resize to Fit Width & Height 

 W: 

H: 

Make sure the longest edge of your image is 1920 
pixels. The other dimension will recalculate 

automatically. 

 Resolution Use Default 

Output 

Sharpening 

✓ Sharpen for Screen 

Metadata No Action  

Watermarking No Action Be sure NOT to watermark your image. Names may not 
appear on the front of any image submitted for 

evaluation or competition. 

Post 

Processing 

No Action This is your choice as to whether you want to see the 

image once you are done. 

Click the Export button. Your file will export to the directory you specified on your computer 

and is now ready to email to the Digital Director: Digital.CCRVA@gmail.com.  

What if I need help? 

If you need help, feel free to contact any of our CCR Board Members, starting with: 

Digital Director: Digital.CCRVA@gmail.com  

Print Director: Prints.CCRVA@gmail.com 

 
  

mailto:Digital.CCRVA@gmail.com
https://www.cameraclubofrichmond.com/ccrdirectors.pdf
mailto:Digital.CCRVA@gmail.com
mailto:Print.CCRVA@gmail.com
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Resizing Images in Adobe Photoshop 

Why do I need to resize my images? 

CCR Accepts digital images for the following:  

• Image Evaluations at Monthly Meetings 

• End of Year Competition 
• Online Member Photo Galleries 
• Monthly Southern Exposure 

• CCR facebook page (we request a watermarked version for facebook) 

All images submitted for any of the above must be as close to and cannot exceed 1920 pixels 
on the longest side of that image and should be under 1 MB (1000K) in size. 

Before resizing your image, be sure ALL IMAGE EDITING IS COMPLETE and you are ready to 

submit your image for evaluation/judging. 

How do I resize my images in Adobe Photoshop? 

Open Photoshop. 

Select File and choose the image you want to resize. 

Select Open and your image will appear. 

Select Image > Image Size.  

You will see this menu: 

 

Adjust the Pixel Dimensions to 1920 Pixels for the longest side: 

• Width for a Horizontal Image 

• Height for a Vertical Image 

The other dimension will be calculated automatically. 

Resolution: Use the default. 

https://www.cameraclubofrichmond.com/image-evaluations
https://www.cameraclubofrichmond.com/f348515942
https://www.cameraclubofrichmond.com/f348515942
https://www.cameraclubofrichmond.com/ccr-newsletter---southern-exposure
http://www.facebook.com/?CameraClubofRichmond
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Click OK. 

Your image may appear smaller on your screen. 

Select File > Save As and name your file into the proper Naming Convention. 

You will then see this window: 

 

Click OK. 

Your image will save to the folder you specified on your hard drive and is now ready to email 

to the Digital Director: Digital.CCRVA@gmail.com. 

What if I need help? 

If you need help, feel free to contact any of our CCR Board Members, starting with: 

Digital Director: Digital.CCRVA@gmail.com  

Print Director: Prints.CCRVA@gmail.com 

 

  

mailto:Digital.CCRVA@gmail.com
https://www.cameraclubofrichmond.com/ccrdirectors.pdf
mailto:Digital.CCRVA@gmail.com
mailto:Prints.CCRVA@gmail.com
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Frequently Asked Questions – AND Answers! 

My Question: The Answer: 

Who can enter the End of Year (EOY) 
Competition? 

Current, paid Camera Club of Richmond (CCR) Members 
may enter. 

Are there any restrictions on the photos I 
enter? 

Yes. Refer to the previously stated General Rules. 

How many photos may I enter? You may enter up to twelve (12) images. 

You are allowed up to FIVE (5) images that have not been 
previously evaluated this year (known as Wildcards). 

Any other images (referred to as Standard Images) must 
have been critiqued at one of the monthly CCR Evaluation 
meetings. 

What is a Wildcard Image? Wildcards are images that have NOT been evaluated at 
one of the current year’s Image Evaluations. Up to 5 of the 
images you submit may be Wildcard images. 

May I submit prints as well as digital images? Unfortunately, in 2021, only digital images may be 
submitted. 

What if I did not participate in the monthly 
Image Evaluations; can I still enter the EOY 
Competition? 

Yes. Since you did not enter any previously evaluated (i.e. 
Standard) images, you may still enter up to 5 images as 
Wildcards. The reason for the rule is to encourage 
everyone to submit images during the year to learn from 
the preliminary Image Evaluations. 

Do we differentiate images between Color 
and Black & White? 

Yes. You will enter your images into either the Color or 
Black & White Color Designation. 

Who determines the Category in which my 
images will be judged? 

Each photographer assigns the Category to each of his/her 
photos based on the Category descriptions. 

If you are unsure which Category to select, please consult 
with one of the CCR Board Members for advice. If the 
judges determine that an image does not meet the criteria 
for its Category, it may be disqualified. 

What happens if I select the “wrong” 
Category? 

If the judges determine that an image does not meet the 
criteria for its Category, it may be disqualified. 

To avoid this, if you are unsure which category to select, 
please consult with one of the CCR Board Members for 
advice before submitting your images. 

https://www.cameraclubofrichmond.com/image-evaluations
https://www.cameraclubofrichmond.com/image-evaluations
https://www.cameraclubofrichmond.com/ccrdirectors.pdf
https://www.cameraclubofrichmond.com/ccrdirectors.pdf
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My Question: The Answer: 

May I enter more than one image in a 
Category? 

Yes. There is no restriction on putting multiple images into 
a single Category. You could put all 12 images into the 
same Category if you so choose. (But you would be 
competing against yourself!) 

May I enter one image into multiple 
Categories or Color Designations? 

No. An image should be submitted only one time. You may 
not submit the same image into two different Categories 
nor as both B&W and Color. 

May I change the title of my Standard 
Image? 

No. The title of a Standard Image must be exactly the 
same title used in the Image Evaluation.  

Is there any exception to the titling rule? Yes, there is one exception: 

An image title may be changed if the Evaluator specifically 
suggested a name change. 

If you choose to make this change, you MUST notify the 
Digital Director with the old and new names. 

What are the rules relating to Assigned 
Subjects? 

Images submitted in an Assigned Subject category, must 
have been submitted in that Assigned Subject category at 
the Image Evaluation for that subject. There are no post-
processing restrictions on Assigned Subject images, so BE 
CREATIVE! 

May I enter a Wildcard into an Assigned 
Subject Category? 

No. A Wildcard will not be accepted for any of the 
Assigned Subject categories. All Assigned Subject 
images MUST have been submitted to the Evaluation for 
that Assigned Subject (thus they must be named as 
“Standard” images.) 

May I incorporate adjustments suggested by 
an Evaluator into the final image submitted 
for EOY Competition? 

Yes. Minor adjustments suggested by the Evaluator are 
permitted. The revised image must originate from the same 
source file. 

May I add a digital frame to my jpg for EOY 
Competition? 

Yes. If you wish to add a digital frame to your image for the 
EOY Competition, this is allowed. Check out our YouTube 
video by Anthony Rumley for instructions. 

What other adjustments may I make to my 
images? 

Images in the six “General” Categories may be enhanced, 
but these manipulations must be kept to a minimum and 
used only to enhance the existing image and ensure 
realism, such as with: levels, exposure, tonal changes, 
sharpening, cloning (for minor retouching).  

You are free to make any and all adjustments to images 
submitted in the “Creative Art” and “Assigned Subject” 
Categories. 

https://www.cameraclubofrichmond.com/image-evaluations
https://www.youtube.com/watch?v=iGLlhrQyf_M&t=9s
https://www.youtube.com/watch?v=iGLlhrQyf_M&t=9s
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My Question: The Answer: 

May I re-submit an image that has been 
submitted in a prior, CCR EOY Competition? 

Yes. You may re-submit an image as long as the image did 
not win any awards in a prior, CCR EOY Competition. 

When is the Submission Deadline for the 
digital version of ALL images? 

The EOY Deadline for ALL digital images is 
Midnight, October 16, 2021. 

What are Credits? Awards earned in the EOY Competition will be assigned 
“Credits”: 

• 1st Place = 3 Credits 

• 2nd Place = 2 Credits 

• 3rd Place = 1 Credit 

• Honorable Mention = 0 Credits 

• Major Awards = 0 Credits (since they have already 
received 3 Credits for earning 1st Place) 

Photographers will accumulate “Credits” to determine when 
they will graduate to a higher Group. 

Records will be kept beginning with the 2021 EOY 
Competition and will be cumulative within each Group 
for a running 3-year timeframe.  

Credits earned as a “Novice/Intermediate” are used to 
determine when to move to “Advanced”. Once there, you 
begin again with “0” and accumulate “Advanced Credits” to 
determine when you move to “Expert”. 

What is Minimum Total Score (MTS)? Instead of assigning Awards based on the number of 
entries in each Category/Color Designation/Group as we 
have done in the past, the CCR Board will assign a 
Minimum Total Score (MTS) for each Group in order to 
determine those “merited awards” that will be recognized. 

Those MTS levels will increase commensurate with the skill 
levels (i.e., Novice/Intermediate MTS will be lower than 
Advanced; and Advanced will be lower than Expert.) 

 

 


